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CPlview requires:

1. A PC running Windows NT, 98, XP, 2000 or Windows 7. Windows 98 cannot
read the NTSF file format written by NT systems (NTSF is the file format used by
the portable drives). Windows 2000 machines will read the NTSF formatted
drives, but a drive that has been used on a 2000 machine will not be readable by
Windows NT unless Windows NT has service pack 5 installed.

2. The PC must also have a licensed version of IDL version 6.3.

3. The PC must also have Adobe® Photoshop or comparable imaging software that
reads Portable Network Graphic (PNG) images.

4. The PC screen resolution must be set to 1024 by 768 pixels or higher.

1 Installing Cpiview

There are several components to the Cpiview software package that need to be
correctly installed on your computer. These files for cpiview have been pre-installed on
your CPI computer, and can be transferred to a computer that meets the above
requirements. These files need to be moved into the following folders if they are not
currently in the directory:

Cpiview.sav to RSI/idI63

Qllogo.jpg to RSI/idI63/lib/hook
EXLogo.jpg to RSI/idI63/lib/hook
CLLogo.jpg to RSI/idI63/lib/hook

Running cpiview: After installing cpiview, open IDL and type “cpiview” at the IDL
command line. This will call up the cpiview program. The correct toolbox (quicklook, or
extractor) will come up. If the toolbox not comes up, then click IDL file, click preference,
Click path, and click insert, then click the CPIView software package directory for it to
be added to the IDL path, then move that directory to the top ( above the IDL default).
Click apply, click ok to close the path setup window. Then type @compilecpi at the IDL
Command line, then type cpiview, this will call up the cpiview program. The correct
toolbox (quicklook, or extractor) will come up. The cpiview interface is shown below.
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A data file must be opened before processing can begin. Data files end in .roi
(which stands for regions of interest). Select the File* menu item and select Open or
click on the File Icon, &, just below the File menu. Move to the appropriate directory
and select a file as you would when opening a file using any other application. Note
that only *.roi files will be shown as choices.

Once the data file is loaded, the first particle will appear in the lower left-hand corner
of the particle display window. The scrolling text box in the lower right portion of the
screen shows: the number of images there are in the file, the number of background
frames, the number of CCD camera pixels, and the location of the current
background frame. Error messages will also be reported in the scrolling text box as
the file is loaded. Step through the file by clicking on the Frame Number slider keys,
[*]or[¢], at the lower left side of the particle display window to step forward or
backward through the file. Information about each frame, including frame time and
the number of particles detected by the PDS but not imaged (missed) are shown in
the scrolling text box. The concentration plot displays the number of ROI's per
frame for the file. The BLUE line marks the current frame, and the YELLOW line
marks the current background. Information about each particle, including extracted

! Words in the Courier Font represent Interface names
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2

2.1

information if an OBJ file has been made (see Extraction Tools section), is displayed
on the right hand side in the Particle Information area when the cursor is placed over
the particle.

A new file can be opened as described in 1 above, or the program can be exited by
selecting Quit under the pull-down File menu.

BASIC FEATURES

Menu Items

Each menu item has a corresponding ToolBar button, the icons are:

File: Fille allows you to load a new *.roi file or to quit the program. You can also
open a *.roi file by pressing the & button.

Edit: The Edit menu allows you to redraw the frame (you can also use ). At
times it is necessary to redraw the frame if the color table (see Tools section below)
has been changed. (The color table is changed when a time series is changed and
may not change back automatically.)

Tools: The Tools menu allows you to generate/view plots (you can also use i)
which will be discussed in the Advanced Features section, as well as adjust the color
table (you can also use ) for dark or light data or if the color table has changed.
Extraction tools: The Extraction Tools menu (you can also use #4), available
on eXtractor, allows you to create *.obj files for better processing.

Help: The Help menu (you can also use &) gives revision notes on this
version of cpiview.

2.2 Particle Information

Particle information is shown to the right of the particle display window. By moving the
mouse cursor over a Region Of Interest (ROI) image, information about the particle is
displayed in the Particle Information area. The information is as follows:

1. Pixel Location: relative location of the cursor over the ROI in pixels.

2. Value: raw value of the cursor over the ROI in data units.

3. Min: minimum value of the ROI pixels.

4. Max: maximum value of the ROI pixels.

5. Mean: mean value of the ROI pixels.

6. Variance: variance of the pixels in the ROI.

7. Cut-off%: the amount of the particle that is cut-off by the boundary of the ROI box.
It can be either user-set by right clicking on the ROI box or auto-extract set via
Extraction Tools. EXtractor calculates cut-off when an *.obj file is made. The
value is a percentage from 0-100, but is stored as a 5-bit value with a range of 0-31.
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8. Focus%: Either user-set or auto-extract set value displaying an estimate of the focus
of the particle. This is user-set by right clicking on the ROI box. Values range from
0-100 with 100 being in focus, the default (rarely the value can be slightly greater
than 100, these should be interpreted as 100). (eXtractor only or can be set with
manual features)

9. Crystal: Either user-set or auto-extract set crystal type classification. This is user-
set by right clicking on the ROI box and choosing a value from 0 — 31. Defaults are
“spheroids” and “ice” based on roundness. (eXtractor only or can be set with
manual features)

10. Roundness: Auto-extract computed roundness value of particle, 0-1.0 (eXtractor
only)

11. Reject: Either user-set or auto-extract set parameter rejecting the particle.
(eXtractor only)

12. ROl Size: Raw length and width from roi file, in microns.

13. Perimeter: Auto-extract computed perimeter in microns. (eXtractor only)

14. Area: Auto-extract computed area in microns. (eXtractor only)

15. Length: Auto-extract computed length in microns. (eXtractor only)

16. Width: Auto-extract computed width in microns. (eXtractor only)

Note: details on Manual Feature Processing (user-set options) are given below.
2.3 Display Options

Display options are shown to the left of the particle display window.
Filtered: When checked, a 4" order median filter is applied to the ROI’s.

Gradient: When checked, a 4" order median filter followed by a Sobel filter is
applied to the ROI’s.

As Mosaic: When checked, the frame is displayed with the ROI's arranged in the
appropriate absolute locations relative to the CCD frame (represented by the box
outline). When unchecked, the ROI’s line up in the particle display window at a
magnification of 1.0.

Cross Section: When checked, the user can select two points on a ROI using the
left mouse button. The points under this line are plotted in the display window.
Unchecking this box will clear the plot.

Pixel Size: The currently active pixel size of the CCD imager in microns. This can
be edited but should be changed back before any processing begins.

Y/X Aspect: The Current aspect ratio applied to the display of ROI's. This can be
edited for non-square pixels.
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2.4 Background Options

Sub. Bckgrnd: When selected and if a background frame exists in the file, the
background is subtracted from each ROI displayed.

Skip Bckgrnd: When selected frames containing backgrounds are skipped. To see a
background frame, unselect Skip Bckgrnd and Sub. Bckgrnd (choose As
Mosaic to see the background fully).

Use as Bkg: Normally, the closest background in the file is the currently selected
background. When viewing a background frame, this is over-ridden by pressing this
button.

2.5 Frame Number: chooses the frame to be displayed

Times:

CP1I: CPI Internal clock time in Hr:Min:Sec:mSec

DAS: Data Acquisition system time in Hr:-Min:Sec:msec
Go: Type in a time (Hr:Min:Sec:msec) to display the image that corresponds to that time
in the particle display window and click Go. If no image exists at the provided time, the
image closest to the time will be displayed.

Zoom: Chooses the magnification factor applied to the display.

3 ADVANCED FEATURES
3.1 Generate/View Plots

The Generate/View Plots option brings up a window that is shown on the next page. A
description of each function is described from the top down.
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3.2 Process and Close

The process and close buttons are how to exit the window. Hit process to generate

and receive the data products chosen below. Hit Close to exit the window without
processing data.
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3.3 Time Period and Air Speed selection

Enter time manually in the Month, Day, Hour, Minute, Sec entry boxes or Select
via buttons. First is the time for the first frame in the file, Current is the time for the
currently displayed frame, and Last is the time for the last frame in the file.
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Airspeed(m/sec): Set the airspeed of the aircraft or the wind speed for surface data
for particle concentration calculations in size distributions and in time series.

3.4 Particle Acceptance Criteria

This option allows manually entered particle acceptance criteria to be used to filter
particles in all subsequent features. Clicking Particle Acceptance Criteria On
enables this feature. Once enabled, criteria must be entered. The criteria are in the
form of an IF (criteria) THEN accept. The criteria are entered in the text box below the
Particle Acceptance Criteria On/Off buttons. Once entered, the criteria can
be saved to a text file with the save button. Once a criterion is saved, it can be recalled
at a later time. In this way, multiple criteria can be easily called up and reused. The
variables available for filtering are presented in the variables droplist. The available
variables depend on whether or not an *.obj file is loaded: Without an *.obj file (or in
Quicklook), the variables are:

Len: represents the length of the raw roi

Wid: represents the width of the raw roi

Focus: represents the focus percentage (must be user set)
Cut-off: represents the Cut-off percentage (must be user set)
Crystal: represents the Crystal type number (must be user set)

Example acceptance criteria are:

Focus gt 75 and Cutoff It 10
Focus ge 50 and Crystal eq 2
Crystal ge 5 and Crystal It 8
Focus gt 20 and len gt 100

With an OBJ file, the variables are:
Len: length of particle along major axis (microns)
Wid: width of particle perpendicular to major axis (microns)
Area: area of particle (square microns)
Perim: perimeter of particle (microns)
Roundness: roundness measure (0-1)
Focus: focus parameter in percent
FocusMin: Minimum focus value for the particle
FocusMax: Maximum focus value for the particle
FocusStdDev: Standard Deviation of the focus values.
Cutoff: amount that particle is cut-off in percent
Crystal: classification number 0-31
P1: user set variable for custom identification purposes 0 or 1
Holearea: the fraction of area above the shadow depth threshold

Acceptance criteria are entered as shown above. SPEC has created acceptance
criteria for particle classification habits, an example of Cirrus cloud acceptance criteria
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strings and notes are shown in Appendix A. Clicking CL will clear all criteria entered
and will not be remembered within the program.

Particle Classification acceptance criteria can be loaded and a classification number or
a 3-letter identifier can be assigned by loading a crystal acceptance criteria and turning
on Make changes to crystal habit? and selecting a crystal type from the drop-
down box. For example, loading a rosette criterion and then selecting the 3-letter
identifier ros ( followed by clicking Process)will assign “ros” to all particles that were
accepted by the rosette criterion. Acceptance criteria can be loaded, and new
identifiers can be selected one at a time until all particles have been classified. If you
want to see and/or save the particles that are being accepted by a criterion while
processing or output all images after all criteria have been loaded with an identifier
labeled on each patrticle, you can click on the appropriate box in Imaging options
(see Output Options section). After habit classification processing, moving the cursor
over the ROI in the main screen and it will now show the manually assigned particle
type in the Crystal box on the right side. If a particle is not accepted by the criteria it
will still be called ice, the default setting. Once a change to the crystal habits was been
made, the OBJ will be forever modified and a new OBJ will need to be made if you want
to start over.

3.5 Particle Size Distributions

Select this feature by clicking the On button. Once enabled, set the Summing
Interval (Seconds). This is the time over which the particle size distributions
(PSDs) will be averaged. To do normal scaling, click on PSD. When the PSD option is
checked, adj/no or adj/lyes must be checked (no adjustment for particle detection
system sensitivity or yes adjustment for particle detection system sensitivity). To do
local scaling, click on wysiwyg_r. It does not matter if adj/no or adj/yes is checked
when wysiwyg_r is checked, it will not have any effect. To make a Conditional PSD click
Conditional PSD on. To add a PMS PSD click on Add_PMS_PSD. These options are
all discussed in more detail in the following sections.

The adj/no option counts each image as one particle assuming the same sample
volume for all particles. The adj/yes option accounts for particle detection system
sensitivity varying with particle size.

To save a hard copy of the PSDs, there are these choices:

e Send to Printer: sends plots for each distribution in the summing interval
selected (if data is present) to the default printer.

e Create png File: produces individual PNG files for each summing interval
selected (if data is present).

e Create ASCII file: produces an ASCII file of the data values plus other info for
each summing interval selected (if data is present).

Each of these options is also available in the Particle Distribution Histogram Viewer
(described next).
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3.6 Normal or wysiwyg r Particle Size Distributions

An example of the Particle Distribution Histogram Viewer (it displays after PSD or
wysiwyg_r is chosen and Process is pressed) is shown below. This window contains
various options for displaying and printing Histograms.

1.
2.
3.

The slider at the top is disabled. Only one period’s PSD can be shown.

The SAF, Ymin, Ymax, Xmin, and Xmax boxes show the plot information.
The slider bars allow the user to modify the minimum bin size (um) and the
minimum number of particles per bin.

Options are available to selectan X or Y Log Scale and Add Mantissa.
Add Mantissa prints values above each bin. These values must be scaled
by the decade value on the vertical axis when in Log Scale.

Checking All will show a PSD of all particles. Checking Liq will show a
PSD of liquid particles only. Checking 1ce will show a PSD of ice particles
only.

Checking on #.L.A_M: shows four other PSD in units of: #/L/um, um/L/um,
mm2/L/um, and mg/L/um.
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7. The buttons at the top of the Particle Distribution Histogram are:

Import ASCII: & Reads a previously saved histogram output file (See
10 Format for Particle Size Distribution ASCII Output for format
details).
Export ASCII: & writes a *.dat file for future analysis with the Particle
Distribution Histogram Viewer or for use with other software.

Print: & and @ both print the current histogram.

Save to PNG: & creates a PNG file for the current Histogram

Exit:x will close the window.

8. The total particle concentration is shown at the top of the PSD. The start time
and the number of seconds in the summing period are next to the top
disabled slider bar.

*Note that if clear air is encountered, empty screens will be displayed with a note saying
“no particles” or “too few particles”.

Below the graph is a line of text showing:

The name of the roi file that was used in creating the histogram.

TF: Total frames captured by the probe during the time interval.

IF: The number of frames that had particles. (IF is a subset of TF)

IP: Total number of particles in the frames.

NRP: Total number of particles that were not rejected by the auto-extraction
process (if you are using eXtractor and have created an obj file).

AP: Total number of accepted particles (the number of particles that passed the
particle acceptance criteria). AP is the number of particles used to calculate the
concentration for the histogram. (AP is a subset of NRP)

7. wysiwyg_r: means PSD is scaled by random mode wysiwyg.

8. #/(LT*SV)/um: means PSD is scaled in the normal way. Sample volume = CPI
live time (LT) X sample area (S) X airspeed (V).

abrwnhpE

o

3.7 Conditional Particle Size Distributions

To look at the conditional PSD, first click Particle Size Distributions Off and
then click Particle Size Distributions On (this will ensure that any earlier PSD
sessions are erased from memory), then click Conditional PSD on. Type in the
Start Time, Stop Time, and the Summing Interval (seconds). Press
Process and this display window will be shown:
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The notes to the right of the display window explain the scale options and the two slider
bars at the top right of the window. The sliders Brk1 and Brk2 determine the N1 and
N2 in the lower left plot. Checking the option wfj will use an adjustment factor that is
greater than 1 to count images that are small. This accounts for small particles having
smaller Depth of Field. Checking the option 1 will count all images as 1 particle
regardless of size. The upper left plot shows the Particle Per Frame
Distribution. The lower left plot shows the distribution of the Number of
Particles in the number/frame bins. The right plot shows the Conditional PSD,
which displays two PSDs segmented by the number of particles per frame (set by Brk1
and Brk2 sliders).

The plots of the conditional PSD can be saved as an ASCII text file, a PNG file, and be
printed as was discussed in the 3.6 Normal or wywiwyg_r Particle Size Distributions
section.

3.8 Add_PMS Particle Size Distributions
This option is for comparing FSSP, 2DC, 2DP, and CPI PSDs in the same time period.

In addition to the CPI *.roi file, a standard formatted data file must be made and put in
the same directory as the *.roi file. This file is generated from Spec Inc’s program
prep_cpiview_input.pro. To run prep_cpiview_input.pro, open it with IDL 6.0 and follow
the prompts. It will input either Net CDF files from the RICO project or SMO files from

SPEC Inc. 11
January 2012



the SPEC Lear. The name of the file will be: mmdd_hhmmss_hhmmss_fssp2dc1Hz.txt,
where mmdd is month and day; hhmmss is hour, minute, second; the first hhmmss is
the start time of the file and the second hhmmss is the end time of the file. The file has
this format:

This file is generated from Spec Inc software prep_cpiview_input.pro
30 This-is-total_number-of-fssp--bins
103 This-is-total_number-of-twodc-bins

BinCenters 0.580 1.54 30 50 70

Bin_Widths 0.360 1.560 20.0 20.0 20.0
30290580 16.0 6.0 2.0 1.8 0.66
30290581 13.0 8.0 1.0 2.8 0.93

The first line is general information.

The second line gives the number of FSSP bins.

The third line gives the number of 2DC bins.

The next lines contain the values of all the bin centers and widths.

After the BinCenters and Bin_Width lines, the first column is the time (in seconds from midnight). The next
column is the bin-height of the first bin of the FSSP (#/L/um). Additional columns will correspond to the
total number of FSSP bins. The next column after the FSSP bin-height columns is the bin-height of the
first bin of the 2DC (#/L/um). Additional columns will correspond to the total number of 2DC bins.

Either the PSD or wysiwyg_r option must be checked on. When the Process button is
pressed, a window will open asking you to load the standard formatted data file. Click
on the first line of data when the ASCI1 Template window opens and then Next,
Next, and Finish. Once a data file is selected and loaded, the Combined PSD
Histogram Viewer will appear to show the PSD comparison.

The standard formatted data file only needs to be loaded once so multiple PSDs can be
made (by going back to Specifty Plotting Options screen) without having to load
the file each time.
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## Combined PSD Histograms
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was discussed in the 3.6 Normal or wywiwyg_r Particle Size Distributions
section.
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Use brkl and brk2 to select the FSSP section when making a combined PSD.
Use brk2 and brk3 to select the CPI section when making a combined PSD.
Use brk3 and brk4 to select the 2DC section when making a combined PSD.
After you have modified the brk1, brk2, brk3, and brk4 boxes, hit ReDo to
redraw the plot with the new settings.
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4 Output Options

Select this feature by clicking the On button. This feature will create PNG files with ROI
images on them and ASCII files with image information in them. Select the boxes to
produce a particular output.

4.1 Imaging options:

Flash png Images when created: as a PNG frame is generated, it is displayed on
the screen for a short time.

Send Accepted Particles to png fTiles: this will send the PNG frame to a file.
An example of a page of images printed from a *.png file is shown below.

Send Accepted Particle Images To Printer: prints a page(s) of image(s) to
the default printer.

2/ 5/2001 07:49-07.51 <=—-mr—-m- >200microns focus gt 20 and cutoff eq 0 and len It 500 and len ¢
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The PNG images contain a header that includes: the date, the time period, a size scale,
and the particle acceptance criteria used. (Note that the scale is only accurate when
the zoom factor is set to 1.0 on the cpiview window (lower left) when the PNG files are
made.)

Next to the output buttons there is a box of options (Parameter added to pngs)
that can be applied to each ROI in the PNG file. These are:
Max Length: add the maximum dimension of the particle (um)
Mean Length: add the mean dimension of the particle (um)
Focus: add focus value (auto-extract created value or manually set value)
Cut-0ff%: add cut-off value (auto-extract created value or manually set value)
Crystal Type: add crystal type number or 3-letter identifier (auto-extract
created value or manually set value)
Roundness: add roundness value (auto-extract created)
Time Label: add time label.

LOG file options are options to create ASCII output. These are:

Particle ASCII1 LOG file: outputs all available data in column format for
each patrticle in two files: *_stats.csv and *_features.csv. Uses eXtracted values
where appropriate.

Frame ASCI1 LOG file: Outputs ASCII log file of data for every frame in
the selected time period.

Hertz Information: Creates a log file containing the probe’s housekeeping
data for the time period selected.

Combined ASCII LOG file: Outputs all available data pertinent to particle
size and dimensions for each particle, like Particle ASCII LOG file but
only creates one file.

Generate Min File: Thisis an outdated option, do not use it.

Log file contents are shown in 9 ASCII Format Definitions.

SPEC programs that use these log files are shown in 10 Format for Particle Size
Distribution ASCII Output.

4.2 Compute Time Series

Select one of the three scaling options buttons to enable computation and display of
time series. Once enabled, select the desired time series. Multiple data can be over-
plotted onto the same graph. The available types are:

1. On/no_adj: to calculate concentration (#/Liter in the sampling period) the
number of imaged patrticles is counted and then divided by the estimated sample
volume. This volume is given by the following equation:

SPEC Inc. 15
January 2012



2.

(sum secs— Y deadtimes)x TAS x cos(rz / 4) x dx x dy x pixsize®

Where TAS is the true airspeed; cos(rz /4)x dx x dy x pixsize? is the cross
sectional sample area.

On/adj : to calculate concentration (#/Liter in the sampling period) each imaged
particle is counted and then the sum is divided by the estimated sample volume.
This volume is given by the following equation:

1/adj x (sumsecs — > deadtimes)x TAS x cos(zr / 4) x dx x dy x pixsize

Where TAS is the true airspeed, cos(z/4) x dx x dy x pixsize’ is the cross
sectional sample area. Adj is greater than or equal to 1. The smaller the
particle the larger adj is. Adj accounts for the reduced probability of detection
of smaller particles.
wysiwyg_r scaled: Every imaged particle in the sampling period is counted
and the sum is calculated. Then the sum is divided by the estimated sample
volume. This volume is given by the following equation:

DOF xtotfrms x area _viewed by camera

The larger the particle is the larger the DOF (depth of field) is. DOF is capped
at the window to window distance. Totfrms is the number of image frames taken
during the time period.

A list of the time series variables:

1.

Concentration: in units of #/Liter.

2. Extinction: in units of 1/km. It is derived from the particle’s projected area

w

© N as

9.

divided by the sample volume.

Ave _Max.Length: average of the max lengths of all particles in sample period
(Hm).

Max .Length: max length of largest particle in sample period (um).

Radar .dBz: radar reflectivity value from all particles.

Image Mean: average value of the CCD frame in data units.

Tot. Frms: number of frames in the sample period, includes empty frames.
Saved Frms: number of frames with ROls in the sample period.

Lig.dBz: radar reflectivity of all liquid particles.

10.Accepted Particles: count of accepted particles in the sample period.
11. Tot. Strobes: number of PDS strobes in the sample period.
12. Accepted Particles/Tot.Strobes: ratio of 10 and 11 above.

13.

Ice.dBz: calculated radar reflectivity from ice particles.

14. DonotUse: reserved for other time series

SPEC Inc.
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15. LWC: Liquid water content.

16. IWC: ICE water content.

17. TWC:Total water content ( which is the sum of liquid and ice water content).
18. DoNotUse: reserved for future usage.

There is also an entry box for Sampling Period (Secs), it sets the averaging
interval for the time series plots.

Note: For calculating IWC and LWC there are two choices, Auto select and Manual
select. Auto select uses the extracted patrticle type for calculating either IWC or
LWC. Manual select allows the user to determine particle type by particle
acceptance criteria. When manual is selected, the patrticle type (as determined by
the extraction process) is ignored. IWC and LWC will be calculated based on the
particles that make it through the particle acceptance criteria. If your acceptance
criteria selects only ice particles, and if you have selected a LWC choice, the result
for LWC will be meaningless.

4.3 Time Series Plots
The time series viewer allows changing of the axis scales and electing between log and

linear Y-axis.

The Options menu contains:
Print: & send plots to printer.
Save Data to File:l write an ASCII file of the data.
Save Plot to PNG: & create a PNG file of the data.
Exit:x will close the window.

SPEC Inc. 17
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4.3.1.3*This is the end of the Generate/View Plots section.

5 Manual Feature
In the main CPIView display window (when the mouse is over an ROI) right click to
bring up the Manual Featuring window. An example is shown below:

€] Manual Featuring =1
Particle Cut-Off3|0 | Focusx(100 |
L = i e B R R e B

L B i e T e = e B

02 08 0 94 0 18 & 2 0 29

e T = R i (T i R e e |

L T R i - e R i e |

5 0 11
Accept | Reject Current ROl | Reject all ROI"z in frame | Cancel |

Set the desired values for Particle Cut-Off% and Focus% in the entry boxes and
select the desired Crystal type (1-31). When done press Accept if satisfied or Cancel
if not. The ROI selected can be rejected by clicking on the Reject Current ROI.
Reject all ROI's in the frame by clicking on Reject all ROI”s in frame. The
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changes will be written to the file when the frame is changed with the Frame Number
slider or the ReDo Frame button is pressed or the application is exited.

6 Extraction Tools (eXtractor only)

The Extraction Tool # performs an analysis on each ROI and creates an object
file (extension .obj). This file contains a rich set of parameters that can be used for
crystal type identification and other classification techniques. If an *.obj file was
previously created and is in the same folder as the *.roi file, then it will automatically be
opened when the *.roi file is opened.

The Auto-extract dialog is presented for fine-tuning of the algorithm.

_lnix

Chooze multiple files I [ Save &5CI LOG files v Extract Features

Select Processing Parameters

12 25 10
B BpE N | EIEC i

tedian Filker Order ROl Darkness Threzhold — Gradient Threzhold

Proceed | Cancel |

To make an *obj file, click on Extract Features, choose thresholds, and Proceed.
If desired, click on Choose multiple files to process more than the currently open
*.roi file. A large *.roi file usually takes more than an hour (depending on computer
speed) to make the *.obj file. A common process is to Choose multiple files and
let it run overnight with a group of *.roi files in their own separate folder. Select Save
ASCI1 LOG filesto create an ASCII version of the binary *.obj file. The Processing
parameters can be adjusted if desired. The parameters are:

Median Filter Order -
This is the number of consecutive applications of a 3x3 Median filter to the image.
The median filter is used to remove "salt and pepper" noise.

ROl Darkness Threshold -
Pixels with values above this threshold are not considered to be part of a particle.
This is the primary criteria used in detecting and sizing particles.

Gradient Threshold -
The magnitude of the 2-D gradient of the image is used to detect particle edges.
Gradient values below this threshold are ignored, while values above it are used
in conjunction with the ROl Darkness Threshold to determine the boundary of
particles.
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Press Proceed to process, or Cancel to abort. During processing, a progess bar is
displayed on the CPIVIEW main display window below the Zoom option. NOTE:
Processing can take a long time! A computer with a 1.0 Ghz processor or better is
recommended. When complete, a dialog box informs the user. If a given *.roi file
does not have a background, the current directory will be searched for a nearby file that
contains a background. This background will be used in the extraction process. The
actual backgrounds used are listed in a log window at the completion of processing all
the files.

6.1 Viewing extracted features:

By moving the mouse pointer over a ROI, information from the extraction appears on
the right hand side of the interface. By left-clicking on any ROI, the perimeter of the
particle is displayed. In some cases, the extraction procedure failed to complete and no
perimeter is displayed. This is noted by the words “Particle Rejected” on the screen.
When an *.obj file is present upon opening an *.roi file, the options available in the
Generate/View plots particle acceptance criteria are increased to include the new
features.

7 Additional features in CPlview

Harmonics (eXtractor only):

In order to view the harmonics for the particle, it is necessary to restart cpiview using
the harmonics key word. l.e. on the IDL command line type “cpiview,/harmonics”. Load
a file that has an *.obj file. Left click on a particle to open the harmonics window. A new
window (as seen below) will appear that shows the radial harmonics as well as the
radial perimeter distances of the particle.
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8 Habit Classification Acceptance Criteria

During the extraction process CPIVIEW sets the variable called ‘crystal’ equal to 15
for ice, 1 for water, and O for rejected particles. You can further modify the values of
‘crystal’ either semi-automatically using the acceptance criteria option or manually by
right clicking on any particle image.

An example of acceptance criteria strings that we use for cirrus clouds follows:

Spheroid:
Focus gt 20 and cutoff It 6 and crystal eq 1

Focus greater than 20 selects only particles of reasonably good image quality.
Cutoff It 6 selects particles that are completely or almost completely in the image frame.
These two requirements are used for all habit types. Crystal eq 1 establishes spheroids
as discussed above.

Column:
Focus gt 20 and cutoff It 6 and crystal ne 1 and (len gt 1.9*wid and perim/area It
1.3*(2*(len+wid)/(len*wid)))

The column acceptance criterion eliminates the spheroids and insists that the length
(len) be at least 1.9 times the width (wid). It also checks that the perimeter (perim) to
area ratio is not too much higher than expected for simple columns.

Plate:

Focus gt 20 and cutoff It 6 and crystal ne 1 and not(len gt 1.9*wid and perim/area It
1.3*(2*(len+wid)/(len*wid))) and (((h2 gt 0.01 and h3 It 0.02 and h4 gt 0.01 and h5 It 0.02
and h6 gt 0.01 and holearea gt 20)or(h2 gt 0.01 and h3 It 0.02 and h5 It 0.02 and h6 gt
0.01 and len It 1.8*wid and len gt 75 and h4 It 0.02) or (len gt 75 and h2 gt 0.01 and len
It 1.8*wid and ((h4 gt 0.01) or (h6 gt 0.01)) and h3 It 0.02 and holearea gt 10)))

The plate acceptance criterion eliminates Columns and spheroids and then
uses the low order harmonics (h2, h3...) and the amount of particle image area
that is above a specified shadow depth in intensity (holearea).

Rosette:

Focus gt 20 and cutoff It 6 and crystal ne 1 and not(len gt 1.9*wid and perim/area It
1.3*(2*(Ilen+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 It 0.02 and h4 gt 0.01 and h5 It
0.02 and h6 gt 0.01 and holearea gt 20)or(h2 gt 0.01 and h3 It 0.02 and h5 It 0.02 and
h6 gt 0.01 and len It 1.8*wid and len gt 75 and h4 It 0.02) or (len gt 75 and h2 gt 0.01
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and len It 1.8*wid and ((h4 gt 0.01) or (h6 gt 0.01)) and h3 It 0.02 and holearea gt 10)))
and ((sgrt(area)/perim It .175 and len gt 80))

The rosette criterion eliminates all of the above habits and then insists on the
perimeter being at least as large as the square root of the area divided by 0.175. It also
requires the length to be greater than 80 microns.

Budding Rosette:

Focus gt 20 and cutoff It 6 and crystal ne 1 and not(len gt 1.9*wid and perim/area It
1.3*(2*(Ilen+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 It 0.02 and h4 gt 0.01 and h5 It
0.02 and h6 gt 0.01 and holearea gt 20)or(h2 gt 0.01 and h3 It 0.02 and h5 It 0.02 and
h6 gt 0.01 and len It 1.8*wid and len gt 75 and h4 It 0.02) or (len gt 75 and h2 gt 0.01
and len It 1.8*wid and ((h4 gt 0.01) or (h6 gt 0.01)) and h3 It 0.02 and holearea gt 10)))
and not((sqgrt(area)/perim It .175 and len gt 80)) and (sqgrt(area)/perim It .2 and len gt 40)

The budding rosette criterion is similar to the rosette criterion but first also eliminates
rosettes and then only requires the perimeter to be at least as large as the square root
of the area divided by 0.2 and also only requires the length to be greater than 40
microns.

Small Irreqular:

Focus gt 20 and cutoff It 6 and crystal ne 1 and not(len gt 1.9*wid and perim/area It
1.3*(2*(Ilen+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 It 0.02 and h4 gt 0.01 and h5 It
0.02 and h6 gt 0.01 and holearea gt 20)or(h2 gt 0.01 and h3 It 0.02 and h5 It 0.02 and
h6 gt 0.01 and len It 1.8*wid and len gt 75 and h4 It 0.02) or (len gt 75 and h2 gt 0.01
and len It 1.8*wid and ((h4 gt 0.01) or (h6 gt 0.01)) and h3 It 0.02 and holearea gt 10)))
and not((sqrt(area)/perim It .175 and len gt 80)) and not(sqrt(area)/perim It .2 and len gt
40) and (len It 200)

The particles not identified by one of the above criteria are classified as small
irregulars if their length is less than 200 microns.

Big Irregular:

Focus gt 20 and cutoff It 6 and crystal ne 1 and not(len gt 1.9*wid and perim/area It
1.3*(2*(len+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 It 0.02 and h4 gt 0.01 and h5 It
0.02 and h6 gt 0.01 and holearea gt 20)or(h2 gt 0.01 and h3 It 0.02 and h5 It 0.02 and
h6 gt 0.01 and len It 1.8*wid and len gt 75 and h4 It 0.02) or (len gt 75 and h2 gt 0.01
and len It 1.8*wid and ((h4 gt 0.01) or (h6 gt 0.01)) and h3 It 0.02 and holearea gt 10)))
and not((sqrt(area)/perim It .175 and len gt 80)) and not(sqrt(area)/perim It .2 and len gt
40) and not(len It 200) and (len ge 200)

The particles not identified by any of the above criteria are classified as big irregulars
if their length is greater than 200 microns.
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9 ASCII Format definitions

ASCII Particle stats File:

Col # | Heading Format Description
1 Year Integer Year of data acquisition
2 mm:dd:hh:mm:ss Integer+float | Month-day-hour-minute-sec (sec is float to milliseconds)
3 ROI# Integer ROI Number in frame
4 ArrTime Integer Arrival time in psec
5 TS Integer Total strobe count
6 DeadTime Float Deadtime in milliseconds
7 Length Float Maximum length in um
8 Width Float Orthogonal width in um
9 Drk Integer Flag ( see note 1 below)
10 Area Float Area in sq. um
11 Perim Float Perimeter in um
12 Centroid Integer array | Co-ordinates of particle centroid in relative pixels
13 Rndness Float Roundness measure
14 X_mnt Float X moment - 1/2 area on each side of vertical line
15 Y _mnt Float Y moment - 1/2 area on each side of horizontal line
16 Rub_band Float Rubber band - Measure of boundary roughness
17 Fract dim Float Fractal dimension
18 SampPer Float Sample period of harmonic array in pixels???
19 Focus Integer % focus 0-100 Mean of 20 points on perimeter (255 indicates failure)
20 Fmin Integer Min of 20 points on perimeter
21 Fmax Integer Max of 20 points on perimeter
22 FStDv Float Standard Deviation of 20 points on perimeter
23 Fgd Integer Focus Good - ???
24 Cutoff Integer Cut-off — percentage that particle is cut-off optically
25 Crystal Integer Crystal type — number specifying crystal type
26 P1 Float Used for internal purposes
27 P2 Float Used for internal purposes
28 P3 Float Used for internal purposes
29 P4 Float Used for internal purposes
30 CurvWin Curvature_Window- # of points in the local radius of curvature
measurement
31 Focus_Stats Float array Focus_Stats — (see note 2 below)
32 Intensity Stats Float array Intensity Stats — same as above stats array
33 IntHL Sts Float array Intensity HoleLess Stats — same as above stats array
34 GradSts Float array Gradient_Stats — same as above stats array
35 RadSts Float array Radii_Stats — same as above stats array
36 CrvSts Float array Curvature Stats — same as above stats array
37 HCnt Integer Hole Count — number of holes found
38 HASts Float array Hole Area Stats — same as above stats array
39 HintSts Float array Hole Intensity Stats — same as above stats array
40 HOSts Float array Hole Other Stats — same as above stats array
41 H1Ar Float Holel Area — area of hole
42 Hllsts Float array Holel Intensity Stats — same as above stats array
43 H1Prm Float Holel Perimeter — perimeter of hole found
44 H1Osts Float array Holel Other_ Stats — same as above stats array
45 H2Ar Float Hole2 Area — area of hole
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46 H2lsts Float array Hole2 Intensity Stats — same as above stats array
47 H2Perim Float Hole2 Perimeter — perimeter of hole found

48 H2Osts Float array Hole2 Other_Stats — same as above stats array
49 H3Ar Float Hole3 Area — area of hole

50 H3lsts Float array Hole3 Intensity Stats — same as above stats array
51 H3Perim Float Hole3 Perimeter — perimeter of hole found

52 H3Osts Float array Hole3 Other_Stats — same as above stats array

ASCI| Particle-features file:

1 HrmCnt Integer Harmonics Count - size of Harmonics array (variable)
2 Harmonics Float Harmonics - array of circular perimeter harmonics
3 BndCnt Integer Boundary Count - size of Boundary array (variable)
4 Boundary Integer Boundary - array of relative perimeter in 1D pixels
5 RadCnt Integer Radii Count - size of Radii array (variable)
6 Radii Float Radii — array of radial lengths from centroid to perimeter (units?)
7 CurvCnt Integer Curvature Count - size of Curvature array (variable)
8 Curvature Float Curvature - local radius of curvature measurement
ASCII Frame File :
Col # | Heading Format Description
1 SZE Integer
2 Version Integer Version number for data file. (determined by age of acquisition gui)
3 RoiCnt Integer Number of roi’'s in frame
4 roisze Integer Number of pixels saved from the frame
5 HouseTime Integer Probe time since beginning of year
6 Date Integer Date format: dd:hh:mm:ss
7 IMGtype Float
8 SX Integer
9 Sy Integer
10 Ex Integer
11 Ey Integer
12 Bgrate Integer Background rate
13 Bkgpdst Integer
14 Frmsproc Integer
15 Ithr Integer
16 Roierr Integer
17 Roiminsz Integer
18 Roiaspect Integer
19 Roifill Integer
20 Roifcnt Integer
21 Imgmn Integer
22 Bkgmn Float
23 Sprl Float
24 ROIXPad Integer x-dim pad around particle in pixels
25 ROlYPad Integer x-dim pad around particle in pixels
26 Strbent
27 Frmssvd Integer
28 Imgminval Integer
29 Imgmaxval Integer
30 Roissvd Integer
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31 Chksum Integer

32 Pdshd1 Integer

33 Pdshd2 Integer

34 Pdshd3 Integer

35 Time Integer

36 Arrivitl

37 Arrvit2

38 Transit_time Transit time

39 Missed Number of pds detections since camera was last available
40 Phghtl

41 Phght2

43 Pdschks

44 prbmode

ASCIl Combined Log File:

Col # | Heading Format Description

1 Year Integer Year of data acquisition

2 mm:dd:hh:mm:ss Integer+float | Month-day-hour-minute-sec (sec is float to milliseconds)
3 ROI# Integer ROI Number in frame

4 ArrTime Integer Arrival time in psec

5 TS Integer Total strobe count

6 DeadTime Float Deadtime in milliseconds

7 Length Float Maximum length in um

8 Width Float Orthogonal width in um

9 Area Float Area in sq. um

10 Perim Float Perimeter in um

11 Focus Integer % focus 0-100 Mean of 20 points on perimeter (255 indicates failure)
12 Cutoff Integer Cut-off — percentage that particle is cut-off optically
13 Crystal Integer Crystal type — number specifying crystal type

14 P1 Float Used for internal purposes

15 IntHL Sts Float array Intensity HoleLess Stats — same as above stats array
16 HrmCnt Integer Harmonics Count - size of Harmonics array (variable)
17 H1 Float Holel Area — Area of Hole

18 H2 Float Hole2 Area — Area of Hole

19 H3 Float Hole3 Area — Area of Hole

20 H4 Float Hole4 Area — Area of Hole

21 H5 Float Hole5 Area — Area of Hole

22 H6 Float Hole6 Area — Area of Hole

23 SX Integer

24 Sy Integer

25 Ex Integer

26 Ey Integer

Notes:

1. Dark parameter codes (Dark: 2-byte word)

Byte Meaning
1% byte darkness number
2" pyte LS 5-bits = Particle cutoff index:
0-31 (no cut-off to almost fully cut-off)
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2: Meaning of Statistic arrays

Array Element Name Meaning

0 N Size of sample set

1 Min Minimum value

2 Max Maximum value

3 Mean Mean value

4 Median Median Value

5 Mode Mode

6 Std Dev Standard Deviation
7 Skewness | Skewness

8 Kurtosis Kurtosis

3.Codes for flag (Flags: 2-byte word)

Bit Number Meaning

0-7 out of focus number

8-11 crystal type O=circular 1=column 2=stellar 3=other
12 Not used.

13 ROI was drawn manually.

14 Crystal type was manually corrected.
15 Particle was manually rejected.

4. Codes for ROl ERROR

Value Meaning

0 No error

ROI is smaller than Min Size limit

ROI Aspect Ratio is outside limits

ROI threshold density is too low - (not used in the newer Probes)

Image intensity was too low to process

OO [(WIN|F

Image intensity was too high to process

ROI record was generated while attempting to capture a background

il
alj=

ROI was generated as a test - Pre-Set ROIs option was selected

10 Format for Particle Size Distribution ASCII output

File header:

Plotcount, sumsecs, pixsize, typescaling, samplevolume, sizetype
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Plotcount: the number of histograms saved in the file.

Sumsecs: the number of seconds averaged for each histogram.
Pixsize: Pixel size. 2.3 microns.

Typescaling: 1 = Total strobes scaling, 0 = Deadtime scaled
Samplevolume: number of liters of air sampled during time period.
Sizetype: ‘mean’ for meansize or ‘max’ for maxsize.

27




Individual data header:

Missed, deadtime, starttime, totfrmcnt, roifrmcnt, totimgpart
Nonrejpart, acceptpart, wysiwyg
Datasize

Missed: Total Strobes count.

Deadtime: Deadtime during the period.

Starttime: Start time for time interval (number of seconds since Jan 1)
Totfrment: Total frame count, the total number of frames taken during the time
period.

Roifrment: Roi frame count, the number of frames that contained roi’s.
Totimgpart: The total number of imaged particles

Nonrejpart: Total number of particles that were not rejected
Acceptepart: Total number of accepted particles.

WYSIWYG: The WYSIWYG concentration for the time period.
Datasize: Number of roi’s in the time interval.

Data: There is one data point for each roi in the interval. The dimension of the particle
is listed in the data section. If the particle was rejected for any reason (obj rejected, or
particle acceptance criteria rejected) the particle dimension is replaced with a 0.0 value.

Appendix 1: CPIl raw data file format information
(This file is given by Jeffrey Schuenke to Brad, Paul, and Tara Jenson on 6/23/1999, user can
use this information to write codes to read and process CPI raw data file if they want to )

A CPI raw .roi file is structured as follows:

{File header} {House Keeping block } {House Keeping block } ... {Frame Block}...
{House Keeping block }...

where the HK blocks occur on 1 second intervals until a frame block is output. The
frame block has priority, so multiple frame blocks may occur before the next HK block.
If the frame blocks take more time to output than 1 seconds, the required HK blocks are
buffered, and output when possible. Each HK block and each Frame block has a time
stamp in seconds of year. Each Frame block has a matching HK block with the same
time stamp. This HK block will always come after the Frame block and has the
deadtime value associated with the frame.

File header structure

Field name Type Description
Ver Int File version
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Year Int Year

Month Int Month

DX Int Max Width of frame
DY Int Max Height of frame
Text BYTARR(70) | Misc. text descriptor

Frame header Structure

Field name Type Description

BlockNum 0 Header Block Marker

ItemSize oL Total bytes in this frameheader only

Ver 0 Version number of this frame

ROIsCount 0 number of ROI's in this frame

TotROIsSize | OL total bytes of IMAGE data

day 0B time of frame 1-31

hour 0B time of frame 0-23

minute 0B time of frame 0-59

sec 0B time of frame 0-59

msec 0 time of frame 0-999

ImgType 0 bit array with data information

SX 0 upper left X corner of image

sy 0 upper left Y corner of image

ex 0 lower right X corner of image

ey 0 lower right Y corner of image

BGRate 0 time between backgrounds in tenths of a second, 0 means
no bckgnds

BkgPDSThre |0 number of machine strobes before a background can be

sh collected

FrmsProc oL total number of frames processed so far

IThresh 0B Image threshold 0-255, 0 means no thresholding done.

ROIErr 0B ROI Rejection/Failure code

ROIMinSize 0 min particle rejection size

ROIAspect 0.0 particle aspect criteria

ROIFill 0.0 min value for (#pixels within ROI threshold)/# pixels in ROI)

ROIFCount oL # pixels within ROI above threshold

ImgMean 0B image mean value

BkgMean 0B background mean value

Sparel 0 Unused

ROIXPad 0 width of border around sides of particle in pixels

ROIlYPad 0 width of border around top/bottom of particle in pixels

StrobeCount | OL Probe's strobe count per image

FrmsSaved oL number of frames saved to disk so far

ImgMinVal 0B min image mean for an acceptable frame

ImgMaxVal 0B max image mean for an acceptable frame

ROlsSaved oL total number of ROI's saved so far

SPEC Inc. 29

January 2012




ChkSum 0 Checksum
PDSHead INTARR( | PDS data block
3)
Time oL seconds of year
ArrivalTl 0 Arrival time ???
ArrivalT2 0 Arrival time ??7?
TransitT 0 Transit time ??7?
Missed 0 number of particles missed while processor is busy
PHeightl 0 ??
PHeight2 0 ?? Note: header file only has one of these listed!!
PDSChkSum | 0 check sum
ProbeMode 0 probe mode

Image header - Data containined in the raw ROI file from the instrument

Field Name | Type | Description

BlockMark | 0 Block mark

ROIlInfoSize | OL Total bytes in this block ( variable because of the last two
fields)

ROIVer 0 Tracks this structures version

SX 0 Start X upper left corner of roi ( relative to CCD frame)

sy 0 Start Y upper left corner of roi ( relative to CCD frame)

ex 0 End X upper left corner of roi ( relative to CCD frame)

ey 0 End Y upper left corner of roi ( relative to CCD frame)

PixBytes 0 Bytes per pixel in image

Flags 0 Contains info about particle ( see definition below)

Len 0.0 Computed Length of particles major axis

SlLen OL 1D index coordinate of start of length vector

ElLen oL 1D index coordinate of end of length vector

Wid 0.0 Computed width of particle ( perpendicular to length
vector)

SWid oL 1D index coordinate of start of width vector

EWid oL 1D index coordinate of end of width vector

Dark 0 Info on particle depth and cut-off (See definition below)

Area Float | Area of roi in pixels

Perimeter Float | Perimeter of roi in pixels

( ROI image data follows each image header. The .min file leaves this data out)

Object Structure Version 30

January 2012

Field name Organizati | Type | Description
on
BlockMark Scalar Int Block mark
ROIlInfoSize Scalar Long | Total bytes in this block ( variable because of the last
two fields)
ROIVer Scalar Int Tracks this structures version
SX Scalar Int Start X upper left corner of roi ( relative to CCD frame)
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Sy Scalar Int Start Y upper left corner of roi ( relative to CCD frame)

Ex Scalar Int End X upper left corner of roi ( relative to CCD frame)

Ey Scalar Int End Y upper left corner of roi ( relative to CCD frame)

PixBytes Scalar Int Bytes per pixel in image ( if zero then image data
excluded!)

Flags Scalar Int Contains info about particle ( see below)

Len Scalar Float | Computed Length of particles major axis

Slen Scalar Long | 1D index coordinate of start of length vector

ELen Scalar Long | 1D index coordinate of end of length vector

wid Scalar Float | Computed width of particle ( perpendicular to length
vector)

SWwid Scalar Long | 1D index coordinate of start of width vector

EWid Scalar Long | 1D index coordinate of end of width vector

Dark Scalar Int Info on particle depth and cut-off (See definition
below)

Area Scalar Float | Area of object in square pixels

Perimeter Scalar Float | Perimeter of object in pixels

Centroid 1D Array Int Centroid of particle ( 2 elements )

Roundness Scalar Float | Measure of particle roundness

X_Moment Scalar Float | 1/2 area on each side of vert line

Y _moment Scalar Float | 1/2 area on each side of horiz line

Rubber Band Scalar Float | Measure of boundary roughness

Fractal dim Scalar Float | Fractal dimension

Harmonic_len Scalar Int Number of elements in Harmonic array

Bound len Scalar Int Number of elements in Boundary array

Sample period Scalar Float | Sample period of harmonic array in pixels

Focus Scalar Byte | % focus 0-100 Mean of 20 points on perimeter

FocusMin Scalar Byte | Min of 20 points on perimeter

FocusMax Scalar Byte | Max of 20 points on perimeter

FocusStdDev Scalar Float | Std Dev of 20 points on perimeter

FocusGoodSam | Scalar Byte |?

ples

CutOff Scalar Byte | % particle is cut-off 0 — 100

Crystal Scalar Byte | Scalar type index meaning TBD

Confidence Scalar Byte | Factor assessing confidence in particle use 0-10

Pl Scalar Float | 1 if manual features set

P2 Scalar Float | Place holder

P3 Scalar Float | Place holder

P4 Scalar Float | Place holder

Harmonics 1D Array Float | Circular harmonics of boundary(var. len)

Boundary 1D Array Int Location of boundary pixels in ROI array ( 1D indicies)

(var. len)

(note: roi image data may follow at this point if PixBytes not equal to zero. Option not
currently implement)
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An object file consists of a file header (see below), and a sequence of object frames. Object frames conatin a frame
header and a sequence of object headers, one for each ROI in the original frame.

Dark: 2-byte word

Byte Meaning
1 byte darkness number
2" byte LS 5-bits = Particle cutoff index:

0-31 (no cut-off to almost fully cut-off)

Flags: 2-byte word

Bit Number Meaning

0-7 out of focus number

8-11 crystal type O=circular 1=column 2=stellar 3=other
12 Not used.

13 ROI was drawn manually.

14 Crystal type was manually corrected.

15 Particle was manually rejected.

Scan List structure; used to gather file info at load time

Field Name | Type | Description

BlockMark | int Marker

Fpos long | File position

ImgType int Image type
1 = normal frame with roi's
2 = background
0 = error type
-1 = house keeping block

HTime long | House keeping time

day byte | Day From header unless HK, then computed
from Htime

hour byte | Hour From header unless HK, then computed
from Htime

minute byte | Minute From header unless HK, then
computed from Htime

sec byte | Sec From header unless HK, then computed
from Htime

msec int Msec From header unless HK, then 0

ROIsCount | int Number of ROI’s in block, 0 for HK blocks

HouseSize | int Size of House Keeping block or 0 if Image
block
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